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Preface

Oracle Identity Manager Connector Guide for PeopleSoft Employee Reconciliation provides 
information about integrating Oracle Identity Manager with PeopleSoft Employee 
Reconciliation.

Audience
This guide is intended for users who want to deploy the Oracle Identity Manager 
connector for PeopleSoft Employee Reconciliation.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at

http://www.oracle.com/accessibility/

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites. 

Note: This is a transitional release following Oracle's acquisition of 
Thor Technologies. Some parts of the product and documentation still 
refer to the original Thor company name and Xellerate product name 
and will be rebranded in future releases.
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TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services 
within the United States of America 24 hours a day, seven days a week. For TTY 
support, call 800.446.2398.

Related Documents
For more information, refer to the following documents in the Oracle Identity Manager 
documentation set:

■ Oracle Identity Manager Release Notes

■ Oracle Identity Manager Installation and Upgrade Guide for JBoss

■ Oracle Identity Manager Installation and Upgrade Guide for WebLogic

■ Oracle Identity Manager Installation and Upgrade Guide for WebSphere

■ Oracle Identity Manager Administrative and User Console Guide

■ Oracle Identity Manager Administrative and User Console Customization Guide

■ Oracle Identity Manager Design Console Guide

■ Oracle Identity Manager Tools Reference Guide

■ Oracle Identity Manager Audit Report Developer Guide

■ Oracle Identity Manager Best Practices Guide

■ Oracle Identity Manager Connector Framework Guide

■ Connector guides for various third-party applications

Documentation Updates
Oracle is committed to delivering the best and most recent information available. For 
information about updates to the Oracle Identity Manager 9.0.0 connector 
documentation set, visit Oracle Technology Network at

http://www.oracle.com/technology/documentation/index.html

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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1
About the Connector

Oracle Identity Manager automates access rights management, security, and 
provisioning of IT resources. Oracle Identity Manager connectors are used to integrate 
Oracle Identity Manager with third-party applications. The connector for PeopleSoft 
Employee Reconciliation is used to integrate Oracle Identity Manager with PeopleSoft 
Employee Reconciliation.

This chapter contains the following sections:

■ Supported Functionality

■ Employee Data Reconciliation

■ Files and Directories That Comprise the Connector

Supported Functionality
Table 1–1 lists the functions that are supported by this connector.

Employee Data Reconciliation
The connector supports employee data reconciliation in two different ways.

■ Bulk Reconciliation (First-time Reconciliation)

This type of reconciliation is done for on-boarding of existing employees using a 
flat file. The flat file is generated using an Application Engine program written in 
PeopleCode. This program is executed using PeoplSoft Application Designer.

Note: Oracle Identity Manager connectors were referred to as 
resource adapters prior to the acquisition of Thor Technologies by 
Oracle.

Table 1–1  Functionality Is Supported by the PeopleSoft Employee Reconciliation Connector

Function Type Description

Trusted Reconciliation 
for Employees

Reconciliation To enable trusted employee reconciliation, you must ensure that the 
required mappings have been created for the Oracle Identity Manager 
user and user resource object. You must also ensure that the 
appropriate rules and action rules have been created and activated.

Untrusted Employee 
Reconciliation

Reconciliation To enable untrusted employee reconciliation, delete the No Match 
Found rule for the untrusted mode reconciliation in the reconciliation 
action rules.
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■ Change Based Reconciliation

This type of reconciliation (automated) takes place using PeopleSoft Application 
Messaging Architecture. This mechanism reconcilies data for any newly created or 
updated employee in real time. 

The Change Based Reconciliation mechanism reconciles employee data with the 
following components:

■ A PeopleCode trigger, which generates an XML message containing updated 
information

■ Attribute definitions (usually resource parameters) to be synchronized

■ A Web service that acts as a passive listener for XML feeds from PeopleSoft

■ An XML file, psft_xellerate_msg.xml, that defines the schema of the XML message 
that will be received from PeopleSoft

The steps involved in the synchronization process from PeopleSoft to Oracle Identity 
Manager are as follows:

1. Employee information is updated in PeopleSoft, activating a PeopleCode trigger.

2. The PeopleCode trigger generates an XML message containing the updated 
employee information and sends it to the listener for the PeopleSoft Employee 
Reconciliation connector.

3. The listener forwards the XML message to the PeopleSoft Employee Reconciliation 
connector.

4. The PeopleSoft Employee Reconciliation connector uses HTTP to send the XML 
message to Oracle Identity Manager. 

5. Oracle Identity Manager receives the XML message and creates a reconciliation 
event.

Figure 1–1 illustrates the synchronization process from PeopleSoft Employee 
Reconciliation to Oracle Identity Manager.

Figure 1–1 Synchronization Process from PeopleSoft Employee Reconciliation to Oracle Identity Manager
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Files and Directories That Comprise the Connector
The files and directories that comprise this connector are compressed in the PeopleSoft 
Employee Reconciliation Rev 3.1.0.zip file, which is in the following directory on the 
installation media:

Enterprise Applications\PeopleSoft Enterprise Applications

The following table lists the files and directories that comprise the connector.

File Name with Path Description

PeopleSoft\XML\adpPSFT_RECON_DM.xml This XML file contains the configuration for the resource 
object.

PeopleSoft\XML\adpPSFT_XellerateUser_RE
CON_DM.xml

This XML file contains the configuration for the Xellerate User. 
You must import this file only if you plan to use the connector 
in trusted source reconciliation mode.

PeopleSoft\lib\peopleSoftApp.war This WAR file contains the PeopleSoft listener Web application. 
It contains all the classes and configuration files required for 
the Web application to run. This is used to implement changed 
base reconiciliation.

PeopleSoft\lib\xlPSFTHRRecon.jar This JAR file contains the class files that are used to implement 
bulk reconciliation.

PeopleSoft\PeopleCode\HRMSCBRecon.txt This file contains the code that you must add to the 
PeopleCode for the SavePostChange event while performing 
the "Publish the Message" procedure.

PeopleSoft\PeopleCode\HRMSBulkRecon.txt This file contains the code for the Application Engine program. 
It is used to generate the flat file for first-time reconciliation.

PeopleSoft\properties\configureReconcil
iation.properties

This file is used to specify the date format used for 
reconciliation.

PeopleSoft\test\psft-xel-test.vbs This VBScript file can be used to test the PeopleSoft listener 
Web service by creating XML feeds similar to the ones created 
by PeopleSoft Employee Reconciliation.

PeopleSoft\test\pingRequest.xml
PeopleSoft\test\pingResponse.xml
PeopleSoft\test\publishRequest.xml
PeopleSoft\test\publishResponse.xml

These XML files are required by the psft-xel-test.vbs file 
for communicating with the PeopleSoft listener Web service 
using XML over HTTP.

PeopleSoft\test\psft_xellerate_msg.xml This XML file is used by the psft-xel-test.vbs file to 
define the schema of the XML message that is received from 
PeopleSoft.

PeopleSoft\docs\PeopleSoft_Employee_Rec
onciliation_Connector_Guide.pdf

This guide provides instructions to deploy the connector.

Note: The files in the test directory are used only to run tests on the 
connector.
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2
Deploying the Connector

Deploying the connector involves the following steps:

■ Step 1: Verifying Deployment Requirements

■ Step 2: Copying the Connector Files and External Code

■ Step 3: Configuring the PeopleSoft Employee Reconciliation Server

■ Step 4: Configuring the PeopleSoft Listener for Change-based Reconciliation

■ Step 5: Importing the Connector XML Files

■ Step 6: Configuring the Reconciliation Module

Step 1: Verifying Deployment Requirements
To verify deployment requirements for the PeopleSoft Employee Reconciliation 
connector:

1. Ensure that your environment meets the requirements listed in the following table.

2. Ensure that you have sufficient administrative rights on the PeopleSoft server to 
perform the following actions: 

■ Create a new message node

■ Configure PeopleSoft Enterprise Portal

■ Add a routing rule to publish messages

Item Requirement

Oracle Identity Manager Oracle Identity Manager release 8.5.3 or later

Target Systems PeopleSoft HRMS 8.9

Ensure that the following components are installed 
and configured:

■ Tuxedo and Jolt (the application server)

■ PeopleSoft Internet Architecture

■ PeopleSoft Application Designer (2-tier mode)

External Code The external code requirement consists of the 
following files:

- HRMSBulkRecon.txt

- HRMSCBRecon.txt
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Step 2: Copying the Connector Files and External Code
The files to be copied and the directories to which you must copy them are given in the 
following table.

■ Copy the adpPSFT_XellerateUser_RECON_DM.xml file from the 
PSFT_Package_Folder\PSFTAdapter\PeopleSoftHRAdapter-3.0.0\XML
\ directory to the xellerate_home\xlclient\ directory. The xlclient folder 
will not pre-exist in OIM installation and need to be created.

■ Copy the adpPSFT_RECON_DM.xml file from the 
PSFT_Package_Folder\PSFTAdapter\PeopleSoftHRAdapter-3.0.0\XML
\ directory to the xellerate_home\xlclient\ directory. 

■ Copy the HRMSBulkRecon.txt and HRMSCBRecon.txt file from the 
PSFT_Adapter_Package\PSFTAdapter\PeopleSoftHRAdapter-3.0.0\Pe
opleCode directory to the xellerate_home\xellerate\Scripts\ directory. 
The Scripts folder will not pre-exist in OIM installation and need to be created.

■ Copy the xlPSFTHRRecon.jar file from the 
PSFT_Package_Folder\PSFTAdapter\PeopleSoftHRAdapter-3.0.0\lib
\ directory to the xellerate_home\xellerate\ScheduleTask\ directory.

■ Copy the configureReconciliation.properties file from the 
PSFT_Package_Folder\PSFTAdapter\PeopleSoftHRAdapter-3.0.0\pro
perties\ directory to the xellerate_home\Scripts\ directory.

Step 3: Configuring the PeopleSoft Employee Reconciliation Server
To configure the PeopleSoft Employee Reconciliation server, use an administrator 
account to perform the following procedures:

■ Creating and Publishing the Message

■ Configuring PeopleSoft Enterprise Portal

■ Configuring PeopleSoft Application Engine Program for Bulk Reconciliation

Creating and Publishing the Message
Perform the following procedures to create and publish the message:

■ Create the Message Channel

■ Create the Message

■ Publish the Message

Create the Message Channel
To create the message channel:

1. Click Start menu, Programs, and then Application Designer from the PeopleSoft 
menu. The PeopleSoft Application Designer (2-tier mode) is displayed.

Note: To open the Application Designer in 2-tier mode you must 
have database client installed on the machine. Additionally, you must 
select the connection type as the respective database (for example, 
Oracle) in the PeopleSoft Application Designer Signon window.
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2. Select New from the File menu. The New Definition dialog box is displayed.

3. In the New Definition dialog box, select Message Channel, and then click OK.

4. Save the new message channel as PERSON_BASIC. 

5. Select Definition Properties from the File menu. The Message Channel Properties 
dialog box is displayed.

6. In the Message Channel Properties dialog box, select the Run option, and then 
select Archive Messages.

Create the Message
After creating the message channel, create the message as follows:

1. In the PeopleSoft Application Designer, select New from the File menu. The New 
Definition dialog box is displayed.

2. Select Message from the list.

3. Select Definition Properties from the File menu. The Message Properties dialog 
box is displayed.

4. Select the Use tab.

5. On the Use tab, select the PERSON_BASIC message channel and the version of 
the message that you just created. 

6. Select Active to make the message an active message.

7. Save the message as PSFT_XELLERATE_MSG.

8. Right-click VERSION_1 and select the Insert Child Record property. A new 
window Insert Record will appear, to choose the records to be added to the 
Message.

9. Enter PERSONAL_DATA in the Name field, and click the Insert button. The 
PERSONAL_DATA record will be added to the message.

10. Repeat steps 8 to 9 for EMPLOYMENT, JOB, DEPT_TBL, DERIVED_HR, and 
PSCAMA records.

11. Clicking on each record will display all the fields pertaining to that record in the 
adjacent window on the right. Select only those fields which are required in the 
XML Message. Refer psft_xellerate_msg.xml to find out the required fields.

12. Save the message again.

Publish the Message
The final step is to publish the message as follows.

1. Select Open from the File menu. The Open Definition dialog box is displayed.

2. Select Component from the Definition list, enter PERSONAL_DATA in the Name 
Selection Criteria field, and then press Enter. All component names starting with 
the text PERSONAL_DATA are displayed. 

3. Select PERSONAL_DATA from the list, and then click Open. The details of the 
PERSONAL_DATA component are displayed.

4. Click the Structure tab, right-click PERSONAL_DATA, and then select View 
PeopleCode. The PeopleCode for the PERSONAL_DATA component is displayed.

5. Select the SavePostChange event from the list in the upper-right corner of the 
window. The PeopleCode for this event is displayed.
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6. Copy the code from the following file immediately after the import definitions in 
the PeopleCode for the SavePostChange event:

xellerate_home\xellerate\Scripts\HRMSCBRecon.txt

7. Add the following function call at the end of the PeopleCode for the 
SavePostChange event:

/**********************************************************************/
/*  Calling the Generate function to generate the 
PSFT_XELLERATE_MSG message*/
/**********************************************************************/
Local string &emplid;
&emplid = PERSON.EMPLID;
GENERATE(&emplid);

8. Select Save from the File menu to save the changes to the PERSONAL_DATA 
component.

Configuring PeopleSoft Enterprise Portal
PeopleSoft Enterprise Portal provides a single gateway to critical information in 
PeopleSoft Employee Reconciliation and other applications and systems. In order to 
use the PeopleSoft Employee Reconciliation connector, you must perform the 
following tasks:

1. Configure the Gateway

2. Create the XL_NODE Remote Node

3. Secure the PERSON_BASIC Message Channel

Configure the Gateway
You must configure the PeopleSoft Enterprise Portal gateway so that messages can be 
sent through the gateway to the connector.

To configure the PeopleSoft Enterprise Portal gateway:

1. Open a Web browser and enter the URL for PeopleSoft Enterprise Portal. The URL 
for PeopleSoft Enterprise Portal is in the following format:

http://servername/psp/Databasename/?cmd=login

For example:

http://psftserver.acme.com/TestDB/?cmd=login

2. Expand PeopleTools, Integration Broker, and then Gateways in the list on the 
portal page. The Gateway component details are displayed.

3. Enter LOCAL in the Integration Gateway ID, and then click Search. The LOCAL 
gateway is a default gateway that is created when you install PeopleSoft 
Enterprise Portal.

4. Ensure that the IP Address in the URL of the PeopleSoft listening connector is the 
IP address of the Web server where PeopleSoft is installed. The URL of the 
PeopleSoft listening connector is in the following format:

Note: Perform this step only if you have already copied the code 
from the HRMSCBRecon.txt file. 
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http://computer_name/PSIGW/PeopleSoftListeningConnector

For example:

http://172.19.151.53/PSIGW/PeopleSoftListeningConnector

5. Click Load Gateway Connectors to load all target connectors that are registered 
with the LOCAL gateway.

6. Click Save.

Create the XL_NODE Remote Node
You must create a XL_NODE node to serve as the remote node.

To create the XL_NODE remote node:

1. In PeopleSoft Enterprise Portal, on the left-hand menu, expand PeopleTools, 
Integration Broker, and Node Definitions.

2. Click the Add a New Value tab. On the Add a New Value tab, enter the Node 
Name as XL_NODE and click the Add button. The Node Definition page is 
displayed.

3. Enter description in the Description field. Make this node a remote node by 
deselecting the Local Node check box and selecting the Active Node check box.

4. Click the Connectors tab, and enter the following information:

Gateway ID: LOCAL

Connector ID: PSFT81TARGET

5. Perform a lookup.

6. Click the Properties link, and enter the following information:

Property ID: PSFT81TARGET

Property Name: URL

Required value: Enter the URL of the PeopleSoft servlet that will receive the XML 
message. This URL is in the following format:

http://computer_name:port/peopleSoftApp/do/peopleSoftAction

For example:

http://172.21.109.75:8080/peopleSoftApp/do/peopleSoftAction

7. Click Save.

8. Click the Transactions tab, and then click Add Transaction. The Add Transaction 
dialog box is displayed.

9. In the Add Transaction dialog box, enter the following details to define the new 
transaction:

Transaction Type: Outbound Asynchronous

Request Message: PSFT_XELLERATE_MSG

Request Message Version: VERSION_1

10. Click Add.

11. To keep the status as active, select Active.

12. Click Save to save the changes.
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Secure the PERSON_BASIC Message Channel
To secure the PERSON_BASIC message channel:

1. In PeopleSoft Enterprise Portal, expand PeopleTools, Security, Permission & 
Roles, and Permission Lists, and then search for the AEAE1000 permission list.

2. Select the Message Monitor tab, and then click Add.

3. Specify PERSON_BASIC as the channel name, and select FULL as the access 
level.

4. Click Save.

5. To verify that the PERSON_BASIC message channel is in running mode:

a. Expand PeopleTools, Integration Broker, Monitor, and Monitor Message.

b. Click the Channel Status tab.

c. Verify that the PERSON_BASIC message channel is running. If it is paused, 
then click Run.

Configuring PeopleSoft Application Engine Program for Bulk Reconciliation
Configuring bulk reconciliation involves:

■ Creating the Application Engine Program 

■ Running the Application Engine in Batch

Creating the Application Engine Program
The bulk reconciliation process requires creating the Application Engine program. To 
create this program, perform the following steps:

1. Click Start, Programs, Peoplesoft8.9hcm, and then Application Designer. The 
Application Designer window, in the 2-tier mode, is displayed.

2. Select New from the File menu. The New Definition dialog box is displayed.

3. Select Application Engine from the Definition list. The App Engine Program 
window is displayed.

4. Click the ‘+’ in front of MAIN. A Step01 is added to the MAIN by default.

5. Rename the Step 01 to Populate.

6. In the App Engine Program window, select Action from the Insert menu. An 
action to Step 01 named Populate is added.

7. From the drop-down list in the action, select PeopleCode.

8. Click Save from the File menu to save the Application Engine Program with name 
BLKPRCS_HR.

9. Double-click the PeopleCode action. A new PeopleCode window is displayed.

10. Copy the code from the   
xellerate_home\xellerate\Scripts\HRMSBulkRecon.txt file. The 
location for output file is mentioned in this code. Change that location to a valid 
location on the PeopleSoft Server. 

11. Close the window and Save the Application Engine Program.
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Running the Application Engine in Batch
To run the Application Engine in batch, perform the following steps:

1. Open the application designer in 2-tier mode.

2. Provide the correct connection type, user ID, and password.

3. Click the File menu, and open the application engine program, which you just 
created.

4. Click the RUN PROGRAM control that exists on the bar just below the Menu bar, 
on the extreme right. The code written on the peoplecode action will get executed.

The comma separated file will get created on the specified location mentioned in the 
code.

Step 4: Configuring the PeopleSoft Listener for Change-based 
Reconciliation

This section describes how to configure the listener for the PeopleSoft Employee 
Reconciliation connector. In the following instructions, xellerate_home refers to the 
local Oracle Identity Manager Server installation directory.

To configure the PeopleSoft Listener:

1. Copy the peopleSoftApp.war file into a temporary directory.

2. Enter the following command to extract the WAR file in the temporary directory:

jar –xvf peopleSoftApp.war

3. Edit the attributemap.properties file in the top-level directory. This file 
contains the mapping between the PeopleSoft attributes that the XML feed will 
contain and the Oracle Identity Manager attribute to which it is mapped. You must 
modify this file on the basis of the local configuration. Apply the following 
guidelines when you modify this file:

a. Obtain the XML schema of the PeopleSoft XML feed from the PeopleSoft 
administrator.

b. Obtain the xpath of all the PeopleSoft attributes. This is the complete path of 
the attribute from the root node in the XML file.

c. Modify the attributemap.properties file by entering name-value pairs. 
Here, name is the Oracle Identity Manager field name and value is the 
PeopleSoft attribute xpath from the XML feed.

4. Edit the deployment.properties file in the top-level directory. This file 
contains only one property, message, that corresponds to the name of the XML 
message from the PeopleSoft feed. The default value of this attribute is 
PSFT_XELLERATE_MSG. Obtain the correct value for this attribute from the 
PeopleSoft administrator.

5. Edit the xlsession.properties file in the top-level directory. This file contains 
the following Oracle Identity Manager connection parameters.

a. ObjectName: This is the name of the resource object in Oracle Identity 
Manager against which the reconciliation event is created. The default value is 
PSFT_HR_RO. However, for untrusted reconciliation, you can change it to any 
other resource object.



Step 4: Configuring the PeopleSoft Listener for Change-based Reconciliation

2-8 Oracle Identity Manager Connector Guide for PeopleSoft Employee Reconciliation

b. Username: This is the user name for logging in to Oracle Identity Manager. 
The default value is xelsysadm.

c. Password: This is the password for logging in to Oracle Identity Manager. The 
default value is xelsysadm.

6. Edit the xlclient.properties file in the top-level directory. This file contains 
the following system properties that enable an API client to communicate with 
Oracle Identity Manager:

a. xl.homedir: This property identifies the Oracle Identity Manager Client 
directory. Typically, the Oracle Identity Manager client directory is 
xellerate_home\xlclient.

b. java.security.policy: This property identifies the path of the security policy 
file. Typically, this file is located in the 
xellerate_home\xlclient\config\ directory.

c. java.security.auth.login.config: This property identifies the path of the 
authentication configuration file. Typically, this file is located in the 
xellerate_home\xlclient\config\ directory.

Each application server uses a different authentication configuration file: 

IBM WebSphere Application Server: authws.conf

BEA WebLogic Application Server: authwl.conf

JBoss Application Server: auth.conf

d. java.naming.provider.url: Identifies the JNP URL of the application server. 
You can find this value by opening the 
xellerate_home\xlclient\config\xlconfig.xml file and locating the 
<Discovery><CoreServer><java.naming.provider.url> tag.

7. Edit the following properties in the configureReconciliation.properties 
file from the top-level directory:

■ reconciliationMode: This property can accept one of two possible values:

– If reconciliation is to be performed in a trusted mode, then set the 
reconciliationMode property to trusted.

– If reconciliation is to be performed in a nontrusted mode, then set the 
reconciliationMode property to nontrusted.

■ Serverdateformat: This property contains the date format that is used for 
the PeopleSoft server. You can select one of the following date formats:

– dd-mmm-yy

– ddmmyy

– yyddmm

– yymmdd

■ xellerateOrganization: This property contains the name of the 
organization. The default value of this parameter is Xellerate Users. The 
value that you assign to this property must exist in Oracle Identity Manager.

■ nullDate: This property contains the default value for a date field. The 
value is 2200/01/01 00:00:00 PST. This value is used if the date field is 
left empty.
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■ PeoplesoftstartingYEAR:  The year is specified in two digits. If the 
number represented by these two digits (xx):

- Is greater than or equal to 50, then it is assumed that the year is 19xx.

- Is less than 50, then it is assumed that the year is 20xx.

 This specifies a range of 1950 to 2049 for the year.

XelServerDate=yyyy/MM/dd hh:mm:ss z : This property contains the date format 
that is used for the Xellerate server.

8. Copy the following files from the xellerate_home\xellerate\lib directory 
to the WEB-INF\lib directory:

■ wlXLSecurityProviders.jar

■ xlAPI.jar

■ xlAuthentication.jar

■ xlBackOfficeBeans.jar

■ xlBackofficeClient.jar

■ xlCache.jar

■ xlCrypto.jar

■ xlDataObjectBeans.jar

■ xlDataObjects.jar

■ xlLogger.jar

■ xlUtils.jar

■ xlVO.jar

Copy the following files from the xellerate_home\xellerate\ext directory 
to the WEB-INF\lib directory:

■ oscache.jar

■ javagroups-all.jar

9. Delete the peopleSoftApp.war file from the temporary directory where you 
extracted it, and then use the following command to re-create the file:

jar –cvf peopleSoftApp.war .

10. You must restart the Oracle Identity Manager server and client before deploying 
the re-created WAR file. In addition, before you start the Oracle Identity Manager 
server and client, ensure that the peopleSoftApp.war file does not exist in the 
application server (JBoss, WebSphere, or WebLogic) deployment directory and in 
the  xellerate_home\xellerate\webapp directory. If it does, then it must be 
deleted. 

If you use JBoss and log4j, then logs are produced and archived on a daily basis in 
the jboss_server_home_dir/log/server.log directory, where 
jboss_server_home_dir is the parent directory in which JBoss is installed. For 
the other application servers, the log file is created and saved in the corresponding 
log directories.

Step 5: Importing the Connector XML Files
To import the connector files:
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1. Open the Oracle Identity Manager Administrative and User Console.

2. Click the Deployment Management link on the left navigation bar.

3. Click the Import link under Deployment Management.  A dialog box for locating 
files is displayed.

4. Locate and open the adpPSFT_RECON_DM.xml file, which is in the 
xellerate_home\xlclient\ directory. Details of the XML file are shown on 
the File Review page.

5. Click Add File. The Substitutions page is displayed.

6. Click Next. The Confirmation window is displayed.

7. Click View Selections.

The contents of the XML file are displayed on the Import page. You may see a 
cross-shaped icon along with some nodes. You must remove these nodes. To do 
this, right-click each such node and then select Remove.

8. Click Import. The connector file is imported into Oracle Identity Manager.

9. If you plan to use the connector in trusted source reconciliation mode, then 
perform steps 1 to 8 to import the xlPSFT_XellerateUser.xml file. This file is 
in the xellerate_home\xlclient\ directory.

Step 6: Configuring the Reconciliation Module
To configure the reconciliation module, you will need to create a scheduled task.

Creating the Schedule Task
To create the schedule task, perform the following steps:

1. Open the Oracle Identity Manager Design Console.

2. Expand the Xellerate Administration folder.

3. Select Task Scheduler.

4. Click Find. The details of the predefined scheduled tasks are displayed on two 
different tabs.

5. Enter a number in the Max Retries field. This number represents the number of 
times Oracle Identity Manager should attempt to complete the task before 
assigning the ERROR status to the task.

6. Ensure that the Disabled and Stop Execution check boxes are cleared.

7. In the Start region, double-click the Start Time field. From the date-time editor 
that is displayed, select the date and time at which you want the task to run.

8. In the Interval region, set the following schedule parameters:

■ To set the task to run on a recurring basis, select the Daily, Weekly, Recurring 
Intervals, Monthly, or Yearly option.

Caution: Only one connector can be configured as a trusted source. 
If you import the xlPSFT_XellerateUser.xml file while you have 
another trusted source configured, then both connector reconciliations 
would stop working.
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If you select the Recurring Intervals option, then you must also specify the 
time interval at which you want the task to run on a recurring basis.

■ To set the task to run only once, select the Once option.

9. Provide values for the attributes of the scheduled task. Refer to the appropriate 
table in the Specifying Values for the Scheduled Task Attributes section for 
information about the values to be specified.

10. Click Save. The scheduled task is created. The INACTIVE status is displayed in 
the Status field, because the task is not currently running. The task is run at the 
date and time that you set in Step 7.

Specifying Values for the Scheduled Task Attributes
This section provides information about the values to be specified for the Employee 
Reconciliation Scheduled Task.

Employee Reconciliation Scheduled Task
You must specify values for the following attributes of the employee reconciliation 
scheduled task.

After you specify values for these task attributes, go to Step 10 of the procedure to 
create scheduled tasks.

Note: Attribute values are predefined in the connector XML file that 
you import. Specify values only for those attributes that you want to 
change.

Attribute Name Description Sample Value

FolderPath This is the Folder Path where PSFT 
generated Employee Reconciliation 
files will be available.

C:\PSFTHR\UserRecon\

TargetSystem Name of the resource object PSFT_HR_RO

IsTrusted Specifies the mode of reconciliation, 
trusted or nontrusted.

YES or NO, Default is No

XellerateOrganizatio
n

Default value for the Oracle 
Identity Manager Organization 
name.

This value is used to create the 
Xellerate User in trusted mode.

Xellerate Users

DateFormatFolderPath This is the path where the 
ConfigureReconciliation.properties 
file will be available.

C:\PSFTHR\DateFormat
\ 
configureReconciliat
ion.properties
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3
Testing the Connector

Testing the connector involves verifying that the PeopleSoft Listener Web application 
can reconcile employees into Oracle Identity Manager. This chapter provides 
instructions on performing this test.

Prerequisites for Testing the PeopleSoft Listener Web Application
The following are prerequisites for testing the PeopleSoft Listener Web application:

■ Ensure that the Microsoft Windows scripting engine is installed. This is required to 
run VBScript files.

■ Ensure that the PeopleSoft XML message schema is described in the 
psft_xellerate_msg.xml file.

Testing the PeopleSoft Listener Web Application
To test the PeopleSoft Listener Web application:

1. In the psft-xel-test.vbs file:

■ Modify the value of the ps_server_url variable so that it points to the URL 
for the PeopleSoft Listener Web application.

■ Specify the required PeopleSoft attributes and employee data values in the 
ExecuteATM function.

2. Run psft-xel-test.vbs. Ensure that the script runs without any errors.

When the script is run, it creates a reconciliation event. Verify that the reconciliation 
event is created in Oracle Identity Manager and that the event contains the data that 
you specify in the VBScript file.
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